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END USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING END USER LICENSE AGREEMENT BEFORE 
ACTIVATING OR USING THIS SOFTWARE PROGRAM.  By Activating, Copying, or otherwise Using this
software, you agree to be bound by the terms of this agreement.  If you do not agree to the terms of the 
agreement, please contact a WattPlot representative at http://www.WattPlot.com to arrange for a license fee 
refund.

This is a legally binding agreement between Andrew Welch, proprietor of Intallact, developer of the WattPlot 
software products (referred to herein as "Intallact" or “Developer”) and any person or company who purchases 
or activates a WattPlot license, or uses the software for any purpose (referred to herein as “End User”).

This software program, and any of the associated files installed with it or transferred from Intallact (via on-line 
transmission or otherwise) to update, supplement, or otherwise modify the software program, as well as any 
printed materials and any on-line or electronic documentation (the “User's Guide”), and any and all copies and 
derivative works of such software program and materials (collectively the “Software”) are the copyrighted 
work of Andrew Welch.  All use of the Software is governed by the terms of this End User License Agreement 
(“License Agreement” or “Agreement”).  The Software is distributed solely for use by authorized end users 
according to the terms of the License Agreement.  Any use, reproduction or redistribution of the Software not 
expressly authorized by the terms of the License Agreement is expressly prohibited.

1. OWNERSHIP.  All title, ownership rights, and intellectual property rights in and to the Software and all 
copies thereof (including, but not limited to, any titles, computer code, artwork, unique interface designs, 
trademarks, proprietary file formats, any related documentation (embedded or separate), and “applets” 
incorporated into the Software) are owned or expressly licensed by Licensor.  The Software is protected by the 
copyright laws of Canada, international copyright treaties and conventions, and other laws.  All rights are 
reserved.  The Software may contain certain licensed materials, and the licensors of those materials may 
enforce their rights in the event of any violation of this License Agreement.

2. LICENSE.  Any data-sharing connection between this copy of the Software and one or more electrical power
monitoring devices (such as a MATE device from OutBack Power Systems), through direct cabling, network 
connection, file-sharing, modem, software interaction, or any other means that does not include a separate 
expressly licensed copy of the Software as a critical link in that communication, is considered an “Active Use” 
of the license.  Each license purchased for this Software allows the Software to be deployed for “Active Use” 
on one computer only.  You may transfer a license to another computer if it is first removed from the original 
computer.  Licenses lost through hardware failure, user error, or otherwise made inaccessible MAY be replaced
by Intallact at the discretion of the Licensor.

3. END USER RESPONSIBILITY.  Subject to the Grant of License hereinabove, you may not, in whole or in 
part, copy, photocopy, reproduce, translate, reverse engineer, derive source code, modify, disassemble, 
decompile, or create derivative works based on the Software, or reproduce the unique interface aspects or Look 
and Feel of the Software, or create software that generates output using the specific proprietary file formats of 
this Software, or remove any copyright or proprietary notices or labels on the Software.  You may not circulate 
or cause to be circulated or make public any aspect of the license activation process, including, but not limited 
to, activation codes (whether delivered from Licensor or generated by Software), software serial numbers, 
unique “PC ID” as generated by Software, or any other information which could knowingly compromise the 
security and integrity of the licensing process, except where such information transfers are between you and the
Licensor or their authorized agent.  Failure to comply with the restrictions and limitations contained in this 
Section 3 shall result in immediate, automatic termination of the license granted hereunder and may subject you
to civil and/or criminal liability.

4. TERMINATION.  This License Agreement is effective until terminated.  You may terminate the License 
Agreement at any time by (i) running the License removal function included with this Software; and (ii) 
permanently removing the Software from your hard drive; and (iii) notifying Licensor of your intention to 
terminate this License Agreement and supplying evidence that the License removal function was run.  Licensor 
may, at its discretion, terminate this License agreement in the event that you fail to comply with the terms and 
conditions contained herein.  In such event, you must immediately and permanently remove the Software from 
your hard drive.  Upon termination of this Agreement for any reason, all licenses granted herein shall 
immediately terminate.
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5. LIMITATION OF LIABILITY.  Neither Licensor nor its subsidiaries or affiliates shall be liable in any way 
for loss or damage of any kind resulting from the use of the Software, including, but not limited to, loss of data,
power equipment damage, electrical power loss, loss of goodwill, work stoppage, computer failure or 
malfunction, or any and all other damages or losses.  Licensor shall not be responsible for any interruptions of 
service, including, but not limited to, software or hardware failures or any other event which may result in loss 
of data, power failure, or disruption of service.  In NO event will Licensor be liable to you for any indirect, 
incidental, special, exemplary, or consequential damages, including, but not limited to events arising from 
normal Software use or errors in Software.  Some countries and regions do not allow the exclusion or limitation
of incidental or consequential damages, so the above limitations may not apply to you.

6. EQUITABLE REMEDIES.  You hereby agree that Licensor would be irreparably damaged if the terms of 
this License Agreement were not specifically enforced, and therefore you agree that Licensor shall be entitled, 
without bond, other security, or proof of damages, to appropriate equitable remedies with respect to breaches of
this License Agreement, in addition to such other remedies as Licensor may otherwise have available to it 
under applicable laws.  In the event any litigation is brought by either party in connection with this License 
Agreement, the prevailing party in such litigation shall be entitled to recover from the other party all the costs, 
attorneys' fees and other expenses incurred by such prevailing party in the litigation.

7. CHANGES TO THE AGREEMENT.  Intallact reserves the right, at its sole discretion, to change, modify, 
add to, supplement or delete any of the terms and conditions of this License Agreement, effective upon prior 
notice as follows: Intallact will post notification of any such changes to this License on the WattPlot web site 
and will post the revised version of this License Agreement in this location, and may provide such other notice 
as Intallact may elect in its sole discretion, which may include by email or pop-up screen.  If any future changes
to this License Agreement are unacceptable to you or cause you to no longer be in compliance with this License
Agreement, you may terminate this License Agreement in accordance with Section 4 herein.  Your installation 
and use of any updated or modifications to the Software or your continued use of the Software following notice
of changes to this Agreement as described above will mean you accept any and all such changes.  The 
Developer may change, modify, suspend, or discontinue any aspect of the Software at any time.  The Developer
may also impose limits on certain features or restrict your access to parts or all of the Software without notice 
or liability.  You have no interest, monetary or otherwise, in any feature or content contained in the Software.

8. MISCELLANEOUS.  This License Agreement shall be deemed to have been made and executed in Canada 
without regard to conflicts of law provisions, and any dispute arising hereunder shall be resolved in accordance 
with the law of Canada.  You agree that any claim asserted in any legal proceeding by one of the parties against
the other shall be commenced and maintained in Canada, having subject matter jurisdiction with respect to the 
dispute between the parties.  In the event that any provision of this License Agreement shall be held by a court 
or other tribunal of competent jurisdiction to be unenforceable, such provision will be enforced to the 
maximum extent permissible, and the remaining portions of this License Agreement shall remain in full force 
and effect.  This License Agreement constitutes and contains the entire agreement between the parties with 
respect to the subject matter hereof  and supersedes any prior oral or written agreements.
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What’s New in Version 5.1.0?

WattPlot™ SumMATE has had regular enhancements and small bug fixes since 
its first release in 2013.  The major improvements for the latest release series are 
listed below:

 SumMATE can now be run unlicensed as a tool to open and view data files 
from another WattPlot application.  (see page 6)

 New scrollable window to display More Information from Daily Summary 
window.  (see page 25)

 Added support for AXS Port device SD Card data files.  (see page 12)

 Added Charge Controller Absorb Time to Daily Summary window.  (see 
page 23)

 Replaced processing interruption due to data errors with cumulative error 
listing in Process MATE3 SD Card Data Files window.  (see page 21)

 Improved ability to process inconsistent data sometimes sent by Radian 
inverters and often found on MATE3 SD Cards.  (see page 21)
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Getting Started

WattPlot™ SumMATE is part of the WattPlot™ 5 suite of software tools for monitoring and controlling 
renewable energy devices such as inverters and charge controllers from OutBack Power Systems.

The WattPlot™ SumMATE application is most commonly used to load, analyse, summarize, and backup 
logged data from a MATE3 SD memory card.  However, it can also accept the following kinds of input:

 .CSV files from MATE3 Data logging - Excel format

 .CSV files from MATE3 Data logging - Compact format

 .CSV files from AXS Port Data logging

 .OBM files from WattPlot Raw Data Capture - Original MATE (Serial format)

 .OBM files from WattPlot Raw Data Capture - MATE3 (UDP/IP or USB formats)

 .CSV monthly summary files created by the WattPlot SumMATE or Monitor programs

 .EPD device data files created by the WattPlot Monitor program

SumMATE can generate the following kinds of output files:

 .CSV monthly summary files (1 file per device per month, 1 line per day)

 Copy of MATE3 or AXS Port .CSV files for backup purposes

 .CSV interval reports – spreadsheets of selected data at specified intervals

SumMATE can display data in the following presentation formats:

 Combination line and bar graph - by month by device

 Daily Summary - by system or by device

 Daily Pen-plot - by system or by device

 Ability to cross between formats and view value details at any time

This Getting Started section will guide you through the installation and configuration of the software.  
The Using WattPlot SumMATE section that follows provides more detailed information on each 
feature.

If you have any questions not answered in this document, or would like to send us feedback or 
suggestions, you can contact us at:

techsupport @ WattPlot .com
http://WattPlot.com
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System Requirements

In order to use any WattPlot™ software, you will need at least the following two things:

 A computer running Microsoft Windows (XP or later), or equivalent emulation

 An OutBack MATE, MATE2, MATE3 or AXS Port monitoring device.  The MATE and MATE2
monitoring devices are technologically equivalent.  This User’s Guide will usually just refer to 
these device types as a MATE.  The MATE3 device, on the other hand, is very different, as is the 
AXS Port device:

MATE MATE2 MATE3 AXS Port

SumMATE Program Installation

STEP 1. From  http://WattPlot.com/download.htm , download the SumMATE setup 
application, called SumMATESetup.msi.

STEP 2. Save the downloaded file on your computer and run  SumMATESetup.msi  (a Windows 
Installer Package).  The setup program will guide you through the installation process.  We 
recommend installing the program (SumMATE.exe) in the default folder specified, which is 
Program Files\WattPlot.  The installation process will also add a shortcut and other 
Resources to your Windows Start menu.

STEP 3. To run the program, click on the WattPlot SumMATE entry of the Windows Start menu 
(under All Programs…WattPlot).  When WattPlot SumMATE is first run, you may be asked 
to Accept the End User License Agreement, a copy of which is included in this manual.

The remaining steps may or may not be prompted for, depending on whether this is your first 
WattPlot software installation, or if SumMATE can use settings that you already have on file.

STEP 4. If your computer is connected to the internet, then you will be prompted to enter your email 
settings.  (See the Email Settings section.)

STEP 5. You will then be prompted to enter a brief descriptive System Name for this installation:
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The System Name identifies this particular MATE connection and the OutBack system that it
monitors.  It will be included in any emails that WattPlot SumMATE sends out.

NOTE:  System Names cannot be easily changed after they have been defined.  Please 
contact WattPlot Support if a change is required.

The Data Folder specifies where WattPlot will store configuration and performance data.  It is
recommended that you accept the default.  You can always change this location later.

If you are defining multiple systems or connection methods, you can use the Description field
to help identify each configuration.

That’s it!  WattPlot SumMATE is now installed.  Note that the program installs in unlicensed mode, 
which is pretty much limited to opening and viewing data files created by other WattPlot applications.  
The following functions require a license activation (see Activation below).  The activation will be 
prompted for when any of the functions are first invoked.

Functions requiring an activation:

 Opening MATE3 or AXS Port data (CSV) files.
 Processing MATE3 or AXS Port SD Card files.
 Updating monthly summaries.
 Creating interval reports.

More information is available in the Using the WattPlot SumMATE Program section.

_____________________________________________________

Release Announcements and other Special Notifications

Installations of WattPlot SumMATE that are connected to the internet will check for new releases of the 
software and other special notifications from WattPlot.  You will be advised if a new version of 
SumMATE has been released into production when you first run the program.

You can adjust how often SumMATE checks for such notifications, using the dropdown menu at the 
bottom of the notification screen, or even turn them off all together.  (See Check for New Release.)

You can also request a manual check for a new release and other special notifications, using the Check 
for New Release entry of the File menu.
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Email Settings

WattPlot SumMATE has a powerful built-in email capability.  Email can be used to:

 Activate your software automatically.
 Send error messages to WattPlot’s technical support for fast resolution.

The Email Settings dialog box will be presented early in the installation process.  You can also access it 
later from the Email Settings entry of the Options menu.

Local (From) Address This is the email address that you normally send from.  Emails sent by 
SumMATE will have this address as the ‘reply-to’.  It will also be the 
address system event notifications will be sent to if no Default 'TO' 
Addresses are specified.

Default 'TO' Address(es) You can specify one or more email addresses which will receive 
SumMATE’s system event notifications.  If none are specified, the Local
(From) Address will be used.  All email addresses must be of the 
“account@domain.ext” format.

SMTP Login

The second section is where you specify your SMTP Server, Port number (if required), SSL Option, User 
Account, and Password.  (The Common Providers menu has the settings for AOL, AT&T, Comcast, 
Gmail, Hotmail, Lycos, Outlook.com, Verizon, and Yahoo.)  The server, user account, and password 
must be present in order to save the data on this screen.  If you are not sure what these settings should be, 
you can often get them by looking at the settings in your regular e-mail program.  If you read your mail 
on-line through a browser, those sites will often have instructions on how to send via SMTP as well.
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Some common SMTP Host servers (such as “smtp.gmail.com”) are recognized by WattPlot and will 
have various other settings defaulted in for you.

Your SMTP Login password and other settings are stored securely in WattPlot’s local data folder in a file 
called vbmail.dat.  WattPlot will only ever transmit data or settings specific to the WattPlot software. 
Login settings will never be transmitted.

Test

It is strongly recommended that you test your SMTP settings.  You can test them by clicking the Test 
button.  A test email message will be sent using the specified Local (From) Address as both the sender 
and recipient.  If all of the settings are correct, you should see the test email message when you check 
your email at that address.  Note that there may be a slight delay while the SMTP server processes the 
email.
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Activation

If you want to go beyond viewing data files 
created by other WattPlot applications, you 
will be need to activate your installation, 
which you can do from the File menu.

You will first be prompted for the serial 
number of your OutBack communications 
device.  If you have a MATE, MATE3, or 
AXS Port, the serial number will be found on
a sticker on the unit.  (The sticker is internal 
for MATE2 units.)  If you have a MATE or 
MATE2, you can get the unit to display the 
serial number by unplugging the network 
cable (leading to your Outback system) from 
your MATE and then plugging it back in.  
Serial numbers are also generally written on 
the box or in the documentation that you 
received with your Outback components.

The full serial number is required, including any leading letters.  After the device serial number has been 
verified, the program will display a Unique PC ID for your computer and prompt for an Activation Code, 
as shown above.

If you have entered Email Settings, and your computer can access the internet, WattPlot SumMATE can 
automatically register your system and issue you with a trial Activation Code, as indicated by the large 
button labeled Request Immediate Trial Activation by Email.  If SumMATE can request an activation 
but cannot issue an automatic one for any reason, then this button may be labeled Request Activation 
Code by Email, which means that we will have to issue an Activation Code manually (usually within 24-
48 hours).  If email is not possible for some reason, then no such button will be visible.

If WattPlot cannot automatically email your activation request, please take note of the unique PC ID that 
is displayed (which will be different from the one shown above) and then click Cancel.  You will have to
email that PC ID to us at  activation @ WattPlot .com  so that we can get a valid Activation Code 
to you.  You can typically expect a response with your Activation Code in 24 to 48 hours.

When you receive your Activation Code, run the program again and enter the code at this prompt 
EXACTLY as you received it.  (We suggest a copy-and-paste from our email directly into the activation 
screen input field.)  Click Activate.

Note:  If you are currently working with an evaluation copy of WattPlot, and have purchased a permanent
license, you can recall this window to enter your new permanent Activation Code by selecting License 
Activation from the File menu.

IMPORTANT NOTICE

WattPlot Activation Codes are issued ONCE.  If you later want to move this license to a different PC, you
can do that yourself.  (See Moving your WattPlot™ License section.)
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MATE3 and AXS Port Data Logging

Since WattPlot™ SumMATE is often used to summarize data logged on to a MATE3 or AXS Port SD 
memory card, we should do a quick overview of SD Card data logging.

The data logging capabilities of the OutBack MATE3 and AXS Port are very useful.  The state of every 
OutBack device in your system can be logged, every second, to an SD memory card, inserted directly into
the device.  No other hardware is required.  Unfortunately, there are some drawbacks:  The data can only 
be accessed by physically removing the card, and the data is not very user-friendly.  SumMATE makes 
the best of the first limitation (speedy processing for a fast SD Card swap), and turns that data into 
beautiful information!

The MATE3’s SD Card configuration screen is accessible through the following menus:

Main Menu   –   Settings Menu   –   MATE3   –   Data Logging

The default mode is Disabled.  We recommend that you enable SD Card Data Logging in Compact mode.
(In fact, Compact mode is an implementation of our suggestion to OutBack for improved MATE3 
capabilities.  Excel mode takes about 25% more storage space.)  In Compact mode, an average SD 
memory card (941 MB) has the capacity to store about 200 device-days at 1-second resolution.  That 
means that if your OutBack renewable energy system has four devices, you could store about 50 days of 
data if your DataLog Write Interval is set to 1 second (system status captured every second).  A system 
with eight devices and a DataLog Write interval of 5 seconds gives you about 125 days of storage.  When 
WattPlot™ SumMATE is processing your MATE3 SD Card data, it can automatically move the files on 
to your PC as a backup, clearing all but the current day's files from the card.

The MATE3 offers DataLog Write intervals of 1, 2, 3, 4, 5, 6, 10, 15, 20, 30, or 60 seconds.  If your 
DataLog Write interval is greater than 1 second, WattPlot™ SumMATE will ‘back-fill’ the values for 
each log into the preceding time gap.  We generally recommend a Write Interval of between 1 and 6 
seconds.
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Using WattPlot™ SumMATE

Major Functions and Typical Usage

Once WattPlot SumMATE has been installed, configured, and activated, there are two categories of 
functionality:  Loading Data and Viewing Information.

Loading Data

For MATE3 and AXS Port users, the most common function for loading data is to bring in it straight 
from the device’s SD memory card.  See Tools – Process MATE3 SD Card Data.  You can also use 
the Open function of the File menu to open a wide variety of MATE data formats.

Viewing Information

The View menu offers different ways to access stored data, including Daily System Summaries and 
Monthly Summaries by Device.  All information views support further drilling-down, switching to plot 
views, and extracting data to spreadsheet reports.

Program Interface

The main program window first appears similar to this:

The primary functions of the application are accessed from the program menus.
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Program Menus

File – Open

The File…Open function is used to open and display any kind of recognized MATE data input file.  
These include:

File name Source and Content Description Opened as

yymmddhh.CSV MATE3 Data logging - Excel format
Not available in Unlicensed Mode

Daily Summary

yymmddhh.CSV MATE3 Data logging - Compact format
Not available in Unlicensed Mode

Daily Summary

yymmddhh.CSV AXS Port Data logging
Not available in Unlicensed Mode

Daily Summary

yyyy-mm-dd_n.OBM From any WattPlot Raw Data Capture function - 
Original MATE (Serial)

Daily Summary

yyyy-mm-dd_n.OBM From any WattPlot Raw Data Capture function - 
MATE3 (UDP/IP or USB)

Daily Summary

Mmm-yyyy_dev
_PowerUsage.CSV

Monthly device summary files from WattPlot 
SumMATE or Monitor program

Monthly
Summary

yyyy-mm-dd_dev.EPD Daily device data from WattPlot Monitor program Daily Summary

LogType.LOG
Operations logs from the WattPlot Monitor 
program, including Alert.log, General.log, 
Comm.log, and Maint.log.

Log Viewer

SumMATE remembers the most recent nine files opened, to allow fast recall from the File menu.  You 
can also drag and drop files from the Windows Explorer on to the SumMATE main screen to open them.

If you have multiple systems defined, when you open a data file, SumMATE will analyse the full file path
in order to guess which system the data pertains to.  If the data doesn’t match the device signatures of the 
guessed system, you will be prompted to identify which system the data is from.

File – License Activation

When you first download and install WattPlot SumMATE, it will run with limited functionality.  In order 
to get full functionality (initially on a trial basis), you may be issued a trial activation, good for about two 
weeks.  If you decide to order a permanent activation, WattPlot will issue you with a permanent activation
key, which must be entered from this menu option.  Selecting Licence Activation will present you with 
the Activation dialog box, where you may enter the activation key.

File – Move License to New PC

(Please see the section on Moving Your WattPlot SumMATE License.)

File – Check for New Release

If SumMATE is running on a computer with internet access, you can ask it to automatically check for 
new releases of the program itself.  This is similar to what it already does automatically when you first 
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run the program.  All notifications will include a few notes about the program changes, and a link to read 
more details and to download the latest version.  The frequency with which you will be informed of a new
release is configurable using the drop-down menu at the bottom of the Special Notifications screen:

Selected Option Effect

List all releases, checking every 10 days

When a new version of WattPlot SumMATE is 
released into production, the program will notify you
no more often than every 10 days.

List all releases, checking every 24 days

When a new version of WattPlot SumMATE is 
released into production, the program will notify you
no more often than every 24 days.  (Default setting.)

List all releases, checking every 90 days

When a new version of WattPlot SumMATE is 
released into production, the program will notify you
no more often than every 90 days.

Disable all release and special notifications

You will not be automatically notified of any new 
releases or special notifications.  If you select this 
option, it is recommended that you do a manual 
check from the Options menu every 6 months.

Note that normally special notifications are one-time messages that only appear once (at program start up)
and will not be repeated.  However, if you use this menu option to check for new releases and special 
notifications, all current special notifications will be shown.

File – Exit

Closes all WattPlot SumMATE windows and exits the application.

System – System Name

WattPlot SumMATE can work with data from several different MATEs.  Each is defined by a separate 
System Name.  The default system for this session is indicated by a check mark.  If you are working with 
data from a different system, it is recommended that you change the default system by selecting the new 
one from this menu.

If you have multiple systems defined, WattPlot SumMATE will prompt you for which system’s data you 
want to work with when it is first run.  You can create shortcuts specific to a pre-selected system which 
will bypass this prompt.  To do so, create a new Windows shortcut for SumMATE, then go to the 
Properties window of the shortcut, and append a space and the System Name (in quotes) to the Target, as
shown in the screen fragment at right.  (Note that the full
target is not shown – "C:\Program
Files\WattPlot\SumMATE.exe".)

You may also wish to rename the shortcut so that you know
which system it refers to.

System – Add/Edit/Remove System
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When WattPlot SumMATE is first installed and run, it will prompt you for the first System Name.  For 
most installations, this is the only System Name that will ever be needed.  If you work with data from 
multiple MATEs, you may wish to define more systems.  Selecting this menu option will present you 
with a list of defined systems:

Choose the Add button to add a new system definition, or the Edit button to edit the selected system.  The
Add and Edit functions use the screen shown below:

System Name This is a brief descriptive name which identifies a particular MATE 
connection and the OutBack system that it monitors.  It will be included 
in any emails that WattPlot SumMATE sends out.  Note that System 
Names are set in the Add screen and are not editable in the Edit screen.  
To change the name, add a new system under the new name and remove 
the old one.

Data Folder This specifies where WattPlot will store configuration and performance 
data.  It is recommended that you accept the default, unless you already 
have WattPlot data elsewhere, or you have a particular need to store data 
in a separate location.  The folder will be created when you click the 
Save button, if it is not already present.

Description Use this free text field to give a more detailed description of the system.

Once a new system is added, it will be appended to the list under the WattPlot System menu.

View – Daily Summary
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Selecting this menu option will present a sub-menu of months that
WattPlot has associated with system-wide data for the current system.
This includes MATE3 or AXS Port Data Log files (named as 
yymmddhh.csv) copied from the SD memory card (see Process
MATE3 SD Card Data) and raw system data in .OBM files
(captured by other WattPlot tools - see their MATE Data Source
dialog box Advanced Settings).  Selecting a month from the sub-
menu will present you with a list of daily data files that WattPlot
SumMATE can find in the designated data folder for the current
system, as shown at right:

In this example, the “.csv” entries refer to groups of hourly SD card
data log files for December 1 to 5, while the last two “.obm” files
listed are raw MATE data for December 5th and 19th.

Selecting a specific daily file (or file set) and clicking OK will load
that data into the Daily Summary Window.

View – Monthly Summary

Selecting this menu option will present a sub-menu of devices that WattPlot has associated with the 
current system.  Selecting a device from the sub-menu will present you with a list of monthly summary 
files that WattPlot SumMATE can find in the designated data folder for the current system.  Finally, 
selecting a specific monthly summary will bring up the Monthly Summary window, as described in the 
Monthly Power Summary section.

View – Status Bar

Turns WattPlot SumMATE’s Status Bar display on or off.

Options – Email Settings

WattPlot SumMATE can use its built-in email functionality to activate your software, notify you of 
critical OutBack system events, and send error messages to WattPlot’s technical support for fast 
resolution.  For details on configuring this functionality, see Email Settings.

Options – Adjust Plot Scales

WattPlot allows you to specify the scale to be used on each pen-plot.  To set the plot scales for a 
particular device or reporting set, click on the entry in the Plot Scales sub-menu of the Options menu, or
right-click on the plot itself and select Adjust Plot Scales.  The Pen Plot Scales Dialog Box will be 
presented.

Options – Compensate for Amperage Truncation
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OutBack inverters (and the older MX-60 charge controller) truncate their reported amperages to the 
nearest whole number.  This means that a reported value of 2 amps might really represent any value 
between 2.0 and 2.9 amps.  WattPlot can compensate for this by using a more average value (2.5 amps) 
for its wattage calculations, etc.  This adjustment will only be applied when the device’s operating mode 
makes such compensation meaningful.  This menu entry will allow you to turn Truncation Compensation 
on or off.

The table below shows four examples of how truncation compensation adjustments are applied:

Device FX-1 FX-2 FX-12 (set) CC
Actual Volts (real world voltage) 119 121 120 30
Actual Amps (real world current) 3.0 - 3.9 1.0 - 1.9 4.0 - 5.9 7.0 - 7.9
MATE Reported Amps (truncated value) 3 1 n/a 7
Watts accumulated/plotted
(with compensation OFF) 357 121 480 210

Adjusted/Calculated Amps 3.5 1.5 5.0 7.5
Watts accumulated/plotted
(with compensation ON) 416.5 181.5 600 225

Actual Wattage (real world power) 357 - 475 121 - 241 478 - 716 210 - 239

Note that actual Amps and actual Wattages are a range.  The truncated value reported by the MATE 
means that the real value could be anywhere in that range.  With compensation turned OFF, only the 
lowest value in the range is used.  With compensation turned ON, the middle value of the range is used.

Options – Select Spreadsheet Program

You can set the file path to the spreadsheet program (such as MS Excel) that SumMATE will use to open 
associated CSV (comma-separated value) files such as monthly power summaries and interval reports.

Tools – Process MATE3 SD Card Data   (only available in fully-licensed program)

This menu option is SumMATE’s primary function for loading and processing MATE3 SD Card data  
For a full description of the function,. see the Processing MATE3 SD Card Data section.

Tools – Update Monthly Summaries   (only available in fully-licensed program)

A function to select specific MATE3 SD card Data Log files (.CSV) or raw MATE data files captured by
a WattPlot Monitor program (.OBM), and update the corresponding monthly summary spreadsheets with 
their data.

Since the Process MATE3 SD Card Data function described above is a more direct way of summarizing 
those files, and the WattPlot Monitor program normally updates the summaries itself, this function is 
really a backup function for those processes, and rarely needs to be run.  It can also be used to 
summarize data files received from another system.

The function begins with the Monthly Summary Update dialog box, as shown below:
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Folder The folder that the data files will be selected from.  You can only process 
files from one folder at a time.  Changing this folder, either directly or using
the Browse button, will change the contents of the Files list on the left.

Browse Enables you to select a new folder.  Note that you are selecting a folder, not
the data files themselves.

Files List of MATE3 Data Log files (.CSV) or raw MATE data files (.OBM) 
found in the specified folder.  Files must be selected (highlighted) by 
clicking on them in order to be processed.  To select multiple files, hold 
down the Ctrl or Shift keys.

Note that MATE3 Data Log files are generated by the hour.  Selecting a 
single one-hour file will cause WattPlot SumMATE to search the same 
folder for all other hourly files that are for the same day and include them in
the processing.

Process Initiates the summarization of the data in all of the highlighted entries of 
the Files list.

Processed Files List of all data files that have just been summarized.

Errors List of any processing errors encountered.

Updated List of all Monthly Summary files affected by the most recent processing.
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View Monthly Summary Displays the Monthly Line/Bar Chart for the selected Updated file.

Close Closes the Update Monthly Summary dialog box.

Tools – Export Interval Data   (only available in fully-licensed program)

Presents the Interval Report Creation Dialog Box corresponding to the currently active device.  The 
currently active device is determined by the top-most Daily Summary or Pen-Plot window.

Tools – SD Card Storage Calculator   (only available in fully-licensed program)

WattPlot SumMATE includes a handy tool to tell you how many days worth of data can be stored on your
MATE3 SD memory card, based on the components that are in your system, the Data Logging settings 
you choose, and the size of the card:

If the program has access to the system definition, the components will be listed, as in the example above,
Otherwise, you will be prompted to select the number of components being monitored by the MATE3.

Windows – Cascade

Arrange all child forms of the main SumMATE screen in overlapping descending order, running left to 
right.

Windows – Tile Vertically

Arrange all child forms of the main SumMATE screen in non-overlapping vertical tiles.

Windows – Tile Horizontally

Arrange all child forms of the main SumMATE screen in non-overlapping horizontal tiles.

Windows – Close All
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Close all child windows of the main SumMATE screen.

Windows – Arrange Icons

Arrange the minimized child windows of the main SumMATE screen.

Help – Helpful Tips

SumMATE has an option to display a different helpful tip about the program every time you start the 
application.  Use this menu entry to turn the option on or off, and also to display the Help Tips window.

Help – SumMATE User’s Guide

This menu entry will call up this User’s Guide as
a hyperlinked and searchable PDF file.

Help – About

WattPlot SumMATE’s About screen provides
useful information such as the current program
version number, the unique PC ID, etc., as shown
at right.  The two paths in red indicate where the
program EXE file is running from and what the
default data folder is for this system.

Help – WattPlot.com

This menu entry has a sub-menu with three options.  Each one will take you directly to a different page of
the WattPlot website:  Frequently Asked Questions, Home Page, and Order Page (for purchasing 
licenses).

built by intal act version 5.0.6 © Copyright 2013-16, Andrew Welch.  All rights reserved.



WattPlot™ SumMATE – User’s Guide 20

Processing MATE3 SD Card Data

The MATE3 and AXS Port devices have the capability of logging all system status data on an SD 
memory card inserted into the side of the device.  A primary function of WattPlot SumMATE is the 
ability to load, analyse, summarize, and backup Data Log files from those SD memory cards with a single
mouse click.

Here is the recommended sequence of events:

1. Remove the SD memory card from the MATE3 or AXS Port.

2. Insert it into the SD card slot of your computer running SumMATE.

3. Select Process MATE3 SD Card Data from the Tools menu.

4. The first time you use this function, you may have to use the Browse button to select the drive 
and/or folder containing the CSV files.  (Note that you are selecting the folder, not the CSV files 
themselves.)

5. The Monthly Summary Update dialog box will appear, as shown below, with all of the 
unprocessed daily MATE3 data file ranges highlighted in the box on the left.  Ranges for days 
already processed by this function will not be highlighted, except for the last day, which will be 
re-processed to collect any end-of-day data.

6. Confirm that the setting to Move or Copy original files after processing is what you want.  (We 
recommend the Move option, which will back up your data files and remove all but the current 
day’s files from the SD Card.)
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7. Click the Process button.  The dialog box will remove file ranges from the left as they are 
processed, and list the actual processed files on the right.  Files with processing errors are shown 
below the other file lists.

In the example given above, the file 15122414.csv had a Data clock roll-back error.  This happens
when the timestamps in the file generated by the OutBack device suddenly jump backwards.  (In 
this case, data was given for every second from 14:00:00 to 14:58:59 and then the next line was 
for 14:00:00 again.)  This appears to be quite a common bug in the MATE3 device (and probably 
the AXS Port).  Please contact OutBack Technical Support for more information.

8. Remove the SD card and return it to your MATE3 or AXS Port to resume the data logging.

9. The drop-down list at the bottom left will list all of the monthly summary files updated by this 
process.  Selecting one and clicking the View Monthly Summary button will open up the 
corresponding Monthly Summary Line/Bar Graph window behind this dialog box.

10. Use the Close button to close the dialog box.
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Daily Summary Window

The primary view of summarized data in WattPlot SumMATE is the Daily Summary window:

The data that it shows represents one day for either a specific device or all devices in a system.  When the 
whole system is shown, the window may include up to four panels:  A summary of all of the inverters, a 
summary of all of the charge controllers, a panel for a FLEXnet DC Monitor (if present), and a panel for 
the battery voltage.

The date and source of the data is indicated in the title bar of the window.  Immediately below that is a 
description of how much time is represented by the data, and when data collection began (if known).

European users please note:  WattPlot supports international decimal formats.  What will appear in this manual as 
“25.6” will be displayed as “25,6” etc., if your computer is setup for European decimal format.

The Device drop-down box allows you to specify either the whole system view (as shown), or the daily 
summary of a specific device as detailed below:

Inverter Summary Panel

Inverter Wh Inverter Watt-Hours – the power produced by the inverter(s) and sent to the loads 
that day.  Obtained by summing the Inverter current multiplied by the AC Out 
voltage.

Charger Wh Charger Watt-Hours – the power used to charge the batteries that day.  Obtained by 
summing the Charger current multiplied by the AC In voltage.

Buy Wh Buy Watt-Hours – the power used from the grid or generator source that day.  
Obtained by summing the Buy current multiplied by the AC In voltage.
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Sell Wh Sell Watt-Hours – the power ‘sold’ back on to the
grid that day.  Obtained by summing the Sell current
multiplied by the AC Out voltage.  (Only applicable
to grid-tied inverters.)

Load Wh Load Watt-Hours – The calculated AC Load power
for that day.  (Inverter Wh – Charger Wh + Buy Wh
– Sell Wh)

Aux Mins The number of minutes that any inverter Aux port
was ON that day.  This is often an indicator of
generator run time.

Aux Buy Wh Displays the power ‘bought’ by the system when the
Aux Port is ON.  This is often an indicator of how
much energy has been input from the generator.

# Warnings Number of inverter warnings received that day.  Details are available from the More
Information button.

# Errors Number of inverter errors received that day.  Details are available from the More 
Information button.

More Information Choosing this button will display a dialog box with extra information such as which 
devices are included in the summary numbers, various minimum or maximum 
values (and what time they occurred), the times spent in each operating mode, as 
well as details on any warnings or errors.  (See More Information Dialog Box.)

Charge Controller Summary Panel

Charger Wh Charger Watt-Hours – the power going to charge 
the batteries that day.  Obtained by summing the 
Charger Current multiplied by the Battery voltage.

PV Wh PV Panel Watt-Hours – the power produced by the 
PV panels that day.  Obtained by summing the PV 
current multiplied by the PV voltage.

Daily kWh Daily Kilowatt-Hours – the power harvested by the 
charge controller(s) that day, as measured by the 
charge controller itself.

Float Mins The number of minutes that the charge controller
was in Float mode that day.  (For multiple devices,
the charge controller with the most Float Time is
shown.)

Absorb Mins The number of minutes that the charge controller was in Absorb mode that day.
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Aux Mins The number of minutes that any charge controller Aux port was ON that day.

Max PV Amp The maximum DC current delivered by the PV array to the charge controller that 
day.  Details are available from the More Information button.

Max PV Volts The maximum DC voltage measured at the charge controller input terminals that 
day.  Details are available from the More Information button.

# Errors Number of charge controller errors received that day.  Details are available from the 
More Information button.

More Information Choosing this button will display a dialog box with extra information such as which 
devices are included in the summary numbers, various minimum or maximum 
values (and what time they occurred), the times spent in each operating mode, as 
well as details on any errors.  (See More Information Dialog Box.)

FLEXnet DC Monitor Summary Panel

Shunt A Wh Shunt A Watt-Hours – the power produced by the
inverter and sent to the loads that day.  Obtained
by summing the Inverter current multiplied by the
AC Out voltage.

Shunt B Wh Shunt B Watt-Hours – the power used to charge
the batteries that day.  Obtained by summing the
Charger current multiplied by the AC In voltage.

Shunt C Wh Shunt C Watt-Hours – the power used from the
grid or generator source that day.  Obtained by
summing the Buy current multiplied by the AC In
voltage.

Relay Closed The number of minutes that the FnDC Aux relay
was CLOSED that day.

Inward kWh Battery input kilowatt-hours, as summed by the FnDC from all shunts, since 
midnight (by the clock on the MATE).  This represents the total power put on to the 
batteries for the day.  Note that this value is only valid if the shunts are not in series!
(See the OutBack FnDC manual for details on proper shunt placement.)

Outward kWh Battery output kilowatt-hours, as summed by the FnDC from all shunts, since 
midnight (by the clock on the MATE).  This represents the total power taken off the 
batteries for the day.  Note that this value is only valid if the shunts are not in series!
(See the OutBack FnDC manual for details on proper shunt placement.)

Inward Ah Battery input amp-hours.  (See details for Inward kWh above.)

Outward Ah Battery output amp-hours.  (See details for Outward kWh above.)
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Min. SOC Minimum State-of-Charge – The lowest State-of-Charge (as a percentage) recorded 
by WattPlot SumMATE for the battery since midnight (by the clock on the MATE).

More Information Choosing this button will display a dialog box with extra information such as 
various minimum or maximum values (and what time they occurred), number of 
days since the battery last met the charge parameters (Days Since Full), as defined 
in the FnDC (when shunt values were reset), as well as details on any warnings.  
(See More Information Dialog Box.)

More Information Dialog Box

Minimums and maximums A summary of minimum and maximum values logged for 
the device on the given day.  Specific values included will 
vary, based on the device type.

Notable events, warnings, and errors Any notable events will be listed, along with the time that 
they occurred.

Time spent in operating modes Inverters and charge controllers have different operating 
modes that they switch in and out of.  The time spent in each
mode will be summarized here.

Battery Voltage Summary Panel

Minimum Minimum Battery Voltage – the lowest battery
voltage recorded for the day.  This value comes
from the FLEXnet DC Monitor (if present) or the
first inverter or charge controller.

Maximum Maximum Battery Voltage – the highest battery voltage recorded for the day.  This 
value comes from the FLEXnet DC Monitor (if present) or the first inverter or 
charge controller.
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Charge Parms Charge Parameters Met (or not) – This message is only applicable if there is a 
FLEXnet DC Monitor present in the system.

Other Daily Summary Buttons

View as Pen Plot Opens the Pen-Plot Window for the currently selected device.

Create Interval Report Presents the Interval Report Creation Dialog Box for the currently 
selected device (or all devices).

Update Monthly Summary Updates the Monthly Summary file for the currently selected device, 
with the data displayed.  This is rarely necessary, since the Monthly 
Summary is usually updated when the data is first brought into WattPlot 
(either by the WattPlot Monitor program or the Process MATE3 SD 
Card Data functions).
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Monthly Power Summary

The Monthly Power Summary records daily information used to track system performance by specific 
device and/or reporting set.

To view the summaries as bar charts and line graphs, open them from the device sub-menus under the 
Monthly Summary selection of WattPlot SumMATE’s View menu, (which can list up to 2 years-worth 
of monthly reports).  Older logs can be opened using the Open function of the File menu.

The Monthly Power Summary graph can have a bar graph component (selected from the drop-down menu
at bottom-left) and a line graph component (selected at bottom-right).

The white background indicates the number of hours that WattPlot has data for.  If the entire column is 
white, then it has data for all 24 hours.  In the example above, the small patch of gray at the top of day 21 
shows that only 22.5 hours was available, while day 23 barely logged any time at all.

Hovering the mouse over a particular day will give you the precise values used in the graphs for that day. 
You can also double-click on any day to open up the detailed pen-plot window for that day.

The log files may also be directly opened by Microsoft Excel or any other spreadsheet program.  Monthly
Power Summaries are stored by month, with a spreadsheet row for each day of the month, and are stored 
in a component’s sub-folder of the Logs folder, using the date and component ID.  For example:

C:\ProgramData\WattPlot\FX-0\Mar-2006_FX-0_PowerUsage.csv

NOTE that if a Monthly Power Summary is left open in the spreadsheet program, additional data cannot 
be written to it.  In such cases, a new file (Mar-2006_FX-0_PowerUsageA.csv) will be created.  
WattPlot will attempt to merge this data back into the base filename at the next update opportunity.
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On most systems (depending on the set-up and availability of other programs), an Open Spreadsheet 
button below the graphs will take you directly into viewing the summary under whatever your default 
spreadsheet application is:

(Because of Excel defaults and CSV file conversion, the date field appears filled with “#”s when you first 
open a WattPlot Power Summary in Microsoft Excel.  Just widen column A to see the dates.)

NOTE that European decimal formats (e.g. “25,6” vDC) are also supported.

The column headings vary, based on the device being summarized (inverter, charge controller, or DC 
monitor), and most should be self-explanatory.  Some specific columns are described below.  Each 
spreadsheet column is totalled along the top (row 2).

Run Time (Hrs) Entries in this column show the amount of data time represented by the data 
shown.

Aux Hrs For FX Monthly Power Summaries, this column will log the amount of time that 
the AUX ON was activated.  If the Aux Port usage (“Cool Fan” in the above 
example) is available (being set by other WattPlot tools), it will be displayed.  
Otherwise the a “???” will be shown.
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Pen-Plot Windows

WattPlot’s signature display of daily device data is the Pen-plot window, showing the changes in MATE 
data values over time.  These windows can be resized by height or width.

For an Inverter (or Inverter set) the plotted values (and their line colors) are:

Inverter Watts (blue) Power produced by the inverter and sent to the loads.  Obtained 
by multiplying the Inverter Current by the AC Out voltage.

Charger Watts (purple) Power used to charge the batteries.  Obtained by multiplying the 
Charger Current by the AC In voltage.

Buy Watts (brown) Power used from the grid or generator source.  Obtained by 
multiplying the Buy Current by the AC In voltage.

Sell Watts (green) Power ‘sold’ back on to the grid.  Obtained by multiplying the 
Sell Current by the AC Out voltage.  (Only applicable to grid-
tied inverters.)

Battery Voltage (red) Actual battery bank voltage.

For a Charge Controller (or Charge Controller set) the plotted values (and their line colors) are:

Charger Watts (purple) Power going to charge the batteries.  Obtained by multiplying 
the Charger Current by the Battery Voltage.

PV Watts (brown) Power produced by the PV panels.  Obtained by multiplying the 
PV Current by the PV Voltage.

Battery Voltage (red) Actual battery bank voltage.
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For a FLEXnet DC the plotted values (and their line colors) are:

State of Charge (purple) Percentage charged for the battery bank.

Shunt 1 Watts (blue) Power passing through Shunt 1.  Obtained by multiplying the 
Shunt 1 Current by the Battery Voltage.

Shunt 2 Watts (brown) Power passing through Shunt 2.  Obtained by multiplying the 
Shunt 2 Current by the Battery Voltage.

Shunt 3 Watts (green) Power passing through Shunt 3.  Obtained by multiplying the 
Shunt 3 Current by the Battery Voltage.

Battery Voltage (red) Actual battery bank voltage.

Hovering the mouse over any part of the pen-plot that has data will bring up a tool tip, indicating the 
specific data values and approximate time associated with the values pointed to.  Points that are off-the-
scale will be indicated by “<” or “>” signs.

Plot Scales

The plot scales are defaulted, based on the model of the device represented, the nominal voltage of the 
battery bank, and by the number of components (if the plot is for a combined reporting set).  You can 
adjust the plot scale in the Pen Plot Scales dialog box, accessible from the Options menu, or by right-
clicking on the plot.  See the Pen Plot Scale Settings section below.

The very top and very bottom of the plots are reserved for points that are off the scale.  The short black 
lines across the top and bottom of the plot represent minutes (or hours in compressed view).  The left-
hand scale is Power in watts, while the right-hand scale is Battery Voltage in VDC.  Hovering your 
mouse over the vertical scale labels will tell you how many watts or volts are represented by the 
horizontal gray lines.

Wattage Totals

The values at the bottom of each current pen-plot window show the accumulated Watt-Hours and how 
they were produced or used.  This corresponds to the wattage totals in the Monthly Summary file.  (See 
Monthly Power Summary section.)  The Wattage totals are reset at midnight (or the next day).

Plot Resolution

Pen-Plots can be viewed at 1 data point (pixel) per second, 1 per minute (60 secs), or 1 per 3 minutes (180
secs), where compressed plots show the calculated average values.  You can also zoom in on a particular 
value by double-clicking a point of the plot.

Plot Time Range

The data time reflected in the visible pen-plot window is indicated to the right of the Plot Resolution.
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Pen-Plot Scale Settings

WattPlot allows you to specify the scale to be used on each pen-plot.  We recommend that you work with 
the optimized default scales until you become familiar with what the program produces and can better 
determine how you might like to fine-tune your plots.

All plot windows are completely resizable, and remember their size parameters, by device, for when new 
plots are opened.

To set the plot scales for a particular device or reporting set, click on the entry in the Plot Scales sub-
menu of the Options menu, or right-click on the plot itself and select Adjust Plot Scales.  The Pen Plot 
Scales dialog box will be presented:

Maximum Wattage Maximum wattage that will appear at the top of the pen-plot (in 
kilowatts).  If the Show Charge/Buy as negative is checked (FX 
inverters only), then this will also be the negative limit at the bottom of 
the plot, otherwise, the bottom of the plot is 0.0 kW
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If the wattage exceeds the plot maximum, then the point will be plotted 
one pixel above the top line, and the wattage will be given as 
“>maximum” when hovering the mouse over that point.

Show Charge/Buy (FX inverters only.)  Splits the pen-plot in half with a centered zero-line.
as negative? Charging and Buying wattages will be plotted as negative values, while 

Inverting and Selling wattages will be plotted as positive values.

Maximum Voltage Maximum battery voltage shown at the top of the pen-plot.  Note that it 
is quite acceptable (and indeed desirable at times) to set this value much 
higher than what the batteries could actually hold, thereby keeping the 
battery plot values together and in the lower part of the pen-plot.

Minimum Voltage Minimum battery voltage shown at the bottom of the pen-plot.  Note that 
it is quite acceptable (and indeed desirable at times) to set this value 
much lower than what the batteries could actually survive at, thereby 
keeping the battery plot values together and in the upper part of the pen-
plot.

Use Limits of Actual Data WattPlot can calculate the optimal resolutions for the given device or 
reporting set, based on the actual data being plotted.  (These values are 
shown in blue above the button.)  Clicking this button will load those 
defaults.  You can then fine-tune them to your preferences.

Continuous plot lines Plot consist of continuous lines that bridge any gaps in data.

Scattered plot points Plot points only appear where actual data was available.

Thicker plot lines If checked, then plot lines appear as double thickness.

MATE Data Resolution

The resolution (precision) of the data provided by the MATE is actually determined by the OutBack 
component that is feeding data to the MATE.  This can vary, based on a number of factors, as tabled 
below:

OutBack Component Battery
Bank

DC Voltage
Resolution

DC Current
Resolution

AC Volt.
Res.

FX inverter (120V systems) 12V 0.1 VDC 1.0 amps 1.0 VAC

FX inverter (120V systems) 24V 0.2 VDC 1.0 amps 1.0 VAC

FX inverter (120V systems) 48V 0.4 VDC 1.0 amps 1.0 VAC

MX charge controller - 1.0 VDC (PV)
0.1 VDC (Battery)

1.0 amps -

FLEXmax 60/80 charge 
controller

- 1.0 VDC (PV)
0.1 VDC (Battery)

1.0 amps (PV)
0.1 amps (Charger)

-

FLEXnet DC monitor - 0.1 VDC (Battery) 0.1 amps -
FX-E inverter (230V systems) 12V 0.1 VDC 0.5 amps 2.0 VAC

FX-E inverter (230V systems) 24V 0.2 VDC 0.5 amps 2.0 VAC

FX-E inverter (230V systems) 48V 0.4 VDC 0.5 amps 2.0 VAC
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Some examples of how the same data from a 48V system might look with different pen-plot scale settings
are shown below:

Pen-Plot Wattage Scale Voltage Scale

Maximum:   12.0

Show Negative:   No

Typical VAC:   120

Resolution =   100%

Maximum:   66.0

Minimum:   26.0

Resolution =   100%

Maximum:   12.0

Show Negative:   No

Typical VAC:   120

Resolution =   100%

Maximum:   58.0

Minimum:   48.0

Resolution =   400%

Note gaps in red line

Maximum:   6.0

Show Negative:   Yes

Typical VAC:   120

Resolution =   100%

Note gray zero-line

Maximum:   60.0

Minimum:   20.0

Resolution =   100%

Maximum:   3.0

Show Negative:   Yes

Typical VAC:   120

Resolution =   200%

Note gaps in Watt lines

Maximum:   60.0

Minimum:   20.0

Resolution =   100%

Plot Right-Click Functions (Scales, Data Exports, Time-of-Day)

Right-clicking anywhere on a pen-plot will present a pop-up menu of miscellaneous functions.  An 
overview of the menu options follows.

Adjust Plot Scales... Presents the Plot Scales dialog box, allowing you to temporarily 
change the plot scales.  (See the Pen-Plot Scale Settings section 
earlier in this guide.)
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Show Point's Raw Data Shows the original values from the Mate that produced that point on
the plot.  (AC In and AC Out might be averages for points in 
surrounding area where all other values are the same).

Start Selection Marks the beginning of a plot section to be selected.  This will 
appear as a vertical yellow line on the plot.

End Selection Marks the end of a plot section to be selected.  This will appear as a 
vertical yellow line on the plot.

Save Selection As… Specify a file name to export the selected plot data to.  You can 
save the selected plot section in three forms:

.CSV file – Generic spreadsheet compatible file of the original 
values from the Mate.  (AC In and AC Out might be averages for 
points in surrounding area where all other values are the same).

.EPD file – A new smaller WattPlot log containing just the selected
pen-plot data (in the same proprietary compressed format).

.TXT file – Raw text of the original values from the Mate.  (AC In 
and AC Out might be averages for points in surrounding area where
all other values are the same).

Clear Selection Clears any start and end selection markers.

Zoom In Switch plot to a higher resolution.

Zoom Out Switch plot to a lower resolution.

Export Interval Data… Presents the Interval Report Creation Dialog Box so that you can 
save the selected plot data as an interval report.

Jump to Time... Prompts for a time-of-day (hh:mm) covered by the currently plot.  
The plot view will change to show the start of the specified minute 
with a yellow line.  (This point will also become a defining point of 
a plot selection, as discussed above.)

Log Viewer

There are at least four kinds of operational logs that can be generated by the WattPlot Monitor program:

General Log Records software activity (e.g. program stop/start), device mode changes, and 
commands sent to the MATE.

Alert Log Records device errors and warnings.

Communication Log Records MATE communication errors and other activity.
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Maintenance Log Records maintenance information intended to be kept for the lifetime of the 
system.  Entries can include bulk and equalization charges, battery maintenance 
details, and free text comments.

These logs are openable in WattPlot SumMATE from the File…Open menu entry as log windows:

Searching and Sorting Logs

All text log windows have a built-in search capability to find entries with specific text, accessible from 
the Show Search button.  Also, any of the logs may be viewed sorted by date, device (component), or 
entry type.  In each case, they may also be viewed with the most recent entries first or last.

Archived Logs

To view archived logs, use the File…Open menu entry and select the log file that you wish to view.  
Archived logs are stored in a log type’s sub-folder of the Logs folder, using the date and log type.  For 
example:

C:\ProgramData\WattPlot\Anderson Home\Alert\2006-03-07_Alert.log

Exporting Log Contents to a Text File

The contents of any text log may be exported to a text file by clicking the Export Text… button, and 
specifying a text file.  The text is exported with the same sorting as is shown in the current log display.
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Archiving / Clearing Logs

To archive log entries into a separate log file, click the log’s Archive & Clear button.  The current file 
will be copied to an archive file, and then the currently file will be deleted and the displayed entries will 
be cleared.

Clicking the Delete Log Entries button will permanently delete the entries from the current log file and
clear the displayed entries.

Interval Reports

Interval reports summarize device performance over a specified time range, broken down into specified 
intervals.  This would allow you to gather hourly wattage totals, for example.  These report can be created
by clicking the Create Interval Report button from the Daily Summary Window, or by right-clicking 
on a pen-plot (with or without a section of plot selected).

Interval reports are created from the following dialog box:
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Licensing, Updates, and Upgrades

Once your one-time license fee payment is received and processed, you will be sent a permanent 
activation code by email.  The WattPlot Monitor software will be licensed to run for a specific 
combination of PC and OutBack MATE/MATE3.

At this time, updates to any of the application programs may be downloaded free of charge, from 
http://WattPlot.com/update.htm , and do not require repeat licensing.  If the program is 
running on a computer that has internet access, you will be informed of significant updates automatically, 
or you can have the program check on request using the Manual Release Check function.

Moving your WattPlot™ Monitor License

Your WattPlot Monitor program license is unique to the PC and hard drive that you installed it on.  If you
wish to move WattPlot to another computer or hard drive, you will need to remove the current license and
get a new activation.  In some situations, you can do this yourself, so long as you have configured 
WattPlot’s Email Settings and your computer can access the internet.  Otherwise, when you remove the 
license, WattPlot will issue you with a temporary license so that you may continue to use the product 
while waiting for the new activation from intallact.

Note that certain hardware changes to a computer can render a WattPlot license invalid.  If 
WattPlot detects this condition, it will revert to a temporary license so that you may continue to use the 
product while waiting for a license update from intallact.  If you know that you will be changing the hard 
drive where WattPlot is installed, we recommend doing a license move first, if possible, even if you have 
not yet installed WattPlot Monitor in the new location.

If you have to move your license back to the original location, this can also be done, but it typically 
requires us to process the new Activation Code and send it to you.  Or you can simply order a new license
if you will require more than one.

The WattPlot Licence Move function is initiated by selecting the Move License to New PC option, 
under the File menu.  Note that this is a license move, not copy.  WattPlot will no longer be licensed at the
old location after the move.  The following steps outline the recommended procedure for removing your 
current license and moving it to a new location.  Please follow whichever steps are possible in your 
situation.

1. If applicable, fully install the WattPlot Monitor program on the new computer or hard drive, as 
described in the SumMATE Program Installation section at the start of this manual.  [Note that the 
version of program running in the new location must be at least equal to or more recent than the 
version of the currently licensed copy.]

2. Run WattPlot Monitor in the new location in order to get the Unique PC ID.  Write this down 
carefully.

3. Run WattPlot Monitor at the old location, where it is already licensed, and select the Move License 
to New PC option, under the File menu.  A confirmation message will be displayed.  Click the Yes 
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if you have the new Unique PC ID.  Otherwise, click No to complete the first step of removing the 
current license.

4. The Activation Dialog Box will be displayed.  If you have the new PC ID, enter it now (including 
hyphens) in the yellow PC ID field, and then press the Enter key.

5. The main action button of the Activation Dialog Box will show the next possible step, based on your 
current situation.  The button will have one of the following labels:

Receive New Activation Code by Email
You can move this license yourself.  Your new activation code will be emailed to you automatically 
within minutes.

Request New Activation Code by Email
You can remove your current license and receive an immediate interim activation.  Intallact will be 
given your new PC ID and will send a you new Activation Code (usually within 24-48 hours).

Proceed With License Move    or    Remove This Activation License
You can remove your current license and receive an immediate interim activation.  When you have 
your new PC ID, You will have to email us at  activation @ WattPlot .com  so that we can 
get a valid Activation Code to you.  Note that we will also need to know your old PC ID and the 
License Removal Confirmation Code, as issued by this process.

6. You will probably want to copy the full contents of the WattPlot folder and any sub-folders to your 
new computer or hard drive, in order to retain all of your logged data and current system settings 
(most of which can be found in your WPConfig.ini and SystemName config.ini files).

7. When you receive your new Activation Code, go to the new installation of WattPlot Monitor and use 
the new Activation Code to activate your license, as described in the Activation section.
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Problems, Feedback, & Suggestions

You will quickly learn that intallact is one of the most responsive developers around.  We are driven by 
the comments and ideas from our users, and rapidly address problems or implement enhancements.

Questions

If you have questions about how to use any of the WattPlot suite of programs, or what they can do, your 
best resource is to start with the Frequently Asked Questions section of our web site.  Go to:

http://WattPlot.com/faq.htm

If the question or answer you seek is not there, please refer to one of the other resources described below.

Solving or reporting problems

If you have a question or you encounter some other difficulty, you are encouraged to contact us by email. 
A screen shot is often useful, acquired by holding down the Ctrl and Alt keys and pressing the Print Scrn 
key.  (You can then Paste the screen shot into an email or Word document, sent as an attachment.)  We 
will work hard to get your issue resolved as soon as possible.

WARNING: Do NOT try to uninstall and reinstall the software.  It won’t help and 
you will likely corrupt your system and data files.  Contact WattPlot support first.

Making suggestions

If there is anything in this User’s Guide that you find unclear, missing, or incorrect, please let us know so 
that we can set the matter straight for you and future users.

If you have an idea about how we can improve our applications or you have a specific need, we would 
love to try and implement your idea.  Send us an email!

techsupport @ WattPlot .com
http://WattPlot.com
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Appendix A -  OutBack Warnings and Errors

The Outback MATE can detect a number of different warning and error conditions coming from inverters
and charge controllers, which are passed on in the data stream.  WattPlot SumMATE can notify you of 
these device errors or warnings by email, if you turn on that functionality.  See Notification Options.

FX warnings will not shutdown the inverter affected, but errors will.  An error on the Master inverter will 
shut the OutBack system down.

This appendix describes some of the errors and warnings detected (sorted alphabetically by message), 
how they are noted, and what they mean.

Inverter Warnings

Warning Trigger Meaning/Response
AC Input 
Frequency High

AC Input frequency is above 
66 Hz (55 Hz on export 
models)

The FX is approaching the upper limit of its frequency window 
and will drop the AC source if the frequency gets much higher.

AC Input 
Frequency Low

AC Input frequency is below 
54 Hz (45 Hz on export 
models)

The FX is approaching the lower limit of its frequency window 
and will drop the AC source if the frequency gets much lower.

Buy Amps 
Exceeds Input 
Size

The AC Input current exceeds 
the rating allowed for that 
model of inverter.

The AC loads are drawing more current than the rating of the FX 
allows.  Exceeding this current limit for an extended period of 
time could cause
the FX to fail.  Reduce the loads on the FX’s AC output to 
prevent damage.

Communication 
Error

An internal communication 
error has been detected 
between the Mate and the FX.

This warning may occur if the communication lines between the 
FX and the MATE have been severed.  If this is the case, turn 
the FX “off” and then “on” through the DC disconnect.  If this 
does not solve the problem, call OutBack for assistance.

Fan Failure The fan mounted above the 
transformer inside the FX has 
stopped working or is not 
functioning properly.

This will eventually cause an Over Temperature inverter error if 
the cause of the fan failure is not fixed.  Restart the FX and listen
for the fan to verify a fan failure.  The fan should run for about 15
seconds on start-up.

Input VAC High AC source voltage exceeds 
the upper limit defined in the 
Mate’s ADV/FX/GRID menu.  
Default is 140 VAC (270 VAC 
on export models).

The AC source (grid or generator) input voltage is too high.  If an
AC source was just applied to the FX, the FX will not connect to 
that source until the voltage drops below the upper limit.

Input VAC Low AC source voltage exceeds 
the lower limit defined in the 
Mate’s ADV/FX/GRID menu.  
Default is 108 VAC (208 VAC 
on export models).

The AC source (grid or generator) input voltage is too low.  If an 
AC source was just applied to the FX, the FX will not connect to 
that source until the voltage rises above the lower limit.  A power 
outage will often trigger this warning.

NOTE:  FX inverters occasionally detect an induced voltage on 
the AC Input terminals of up to 10 VAC, even if they are not 
connected to an AC source or the grid is down.  WattPlot 
suppresses this warning at such voltage levels.

Temperature 
Sensor Failed

One of the temperature 
sensors internally located in 
the FX is not working correctly.

The FX needs to be checked by a qualified repair technician.  
Note that the AirTemp, FETtemp and CapTemp warnings listed 
in the Mate’s STATUS/FX/WARN menu can help with 
troubleshooting.
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Inverter Errors

Error Trigger Meaning/Response
Backfeed Another AC source of power 

was connected to the AC 
output of the FX.

Usually this is an installation issue. It often occurs when there is 
an X-240 transformer in the system that hasn’t been installed 
properly.  Also, check that there are no connections between the 
AC input and AC output circuitry.

High Battery The battery voltage rose above
the high battery voltage level 
(40.0 volts for a 24V FX) for 10
seconds.

The inverter will restart once the battery voltage drops below the 
high battery voltage level (40.0 volts for a 24V FX) for at least 1 
second.

Low Battery The battery voltage dropped 
below the Low Battery Cut-Out
(LBCO) voltage set point for 5 
minutes.  (Default LBCO is 
21.0 volts for a 24V FX.)

The inverter will restart once the battery voltage exceeds the 
Low Battery Cut-In (LBCI) voltage set point for 10 minutes. 
(Default LBCI is 25.0 volts for a 24V FX.)

Low VAC 
Output

The inverter was not able to 
maintain adequate AC output 
voltage to power the loads 
connected.  AC output 
dropped below 105 VAC (200 
VAC for export models).

This is typically caused by the AC loads demanding more power 
than the inverter is able to deliver.

Over 
Temperature

The FX reached its maximum 
allowed internal operating 
temperature.

This can be caused by powering large AC loads or charging for 
too long.  It can also be caused by restricting the amount of air 
which is able to flow around the casting, or by operation in high 
temperature environments.  The inverter will automatically reset 
and resume operation once it cools down.

Phase Loss n/a Phase Loss error detection has not yet been implemented by 
Outback, and is not operational at this time.  Please inform 
intallact if this error is triggered on your system.

Shorted Output The inverter immediately 
reached its maximum current 
and shut down.

This is usually caused by a short circuit condition on the AC 
output, but can also be caused by attempting to operate a load 
which far exceeded the inverter output capability.

Stacking Error A problem has occurred with 
the communication cabling 
between stacked inverters, or 
the inverters are stacked 
incorrectly.

Check the stacking programming on the Mate.  If this condition 
persists contact your dealer for servicing instructions.
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WattPlot Program Errors

Error Trigger Meaning/Response
Activation Code 
Expired

User attempted to activate 
WattPlot with an expired 
activation code.

There are two kinds of activation codes from intallact: 
Evaluation and Permanent.  An evaluation activation code is 
typically valid for about 15 days from the date it is sent to you, 
not the date that you first use it.  If the code expired before you 
could use it, contact us at activation @ WattPlot .com.

Authorization 
Failed

Invalid activation code or other
licensing error.

There are a number of things that can trigger this error.  Please 
send the exact text of the error message to us at activation @
WattPlot .com.

Configuration 
Corrupted

An inconsistency in the 
WattPlot configuration file.

WattPlot keeps a lot of configuration information in a data file 
(solrwind.ini) in its application folder.  If WattPlot detects an 
inconsistency in this file, then this error will be generated.  If you 
get this error, attach the file (solrwind.ini) to an email & send it to 
us at techsupport @ WattPlot .com.

Encountered 
invalid log data

Unexpected values in 
WattPlot’s own data files.

Data corruption error, indicating a data storage problem, 
inappropriate manual editing, or a program bug that we should 
know about.  Please send data file to us at techsupport @ 

WattPlot .com.

Installation 
Aborted 
(Licensing Error 
Code)

Internal error from a Windows 
function.

This is an internal licensing error related to Windows.  Please 
contact us at activation @ WattPlot .com if you get this 
error.

Installation 
Aborted 
(Unrecognized 
MATE Serial 
Number)

User entered an invalid MATE 
serial number.

For MATE/MATE2 devices:  Be sure to include the “MA” and all 
leading zeroes when entering your MATE serial number.

For MATE3 devices:  Be sure to include the “M” when entering 
your MATE serial number.

Software 
Expired

Expiry date of temporary 
evaluation license has passed.

An evaluation activation code is typically valid for about 15 days 
from the date it is sent to you, not the date that you first use it.  If 
you need an evaluation period extension, contact us at  
activation @ WattPlot .com.  You can get information about
ordering a permanent WattPlot license at our web site: 
WattPlot.com/order.htm

Unrecoverable 
Error - Inform 
intallact

Internal programming error. While we have attempted to anticipate every possible error 
condition, it is always possible that the WattPlot software will 
encounter an internal programming error.  While these are more 
and more rare, they almost always indicate something that our 
developer must address immediately.

This error is usually accompanied by extra information which, if 
emailed to us, will allow our programmer to quickly track down 
the cause of this error.
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